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Disclaimer

The information contained in this manual is correct and accurate at the time of its publication.
ATD reserves the right to change or alter any information or technical specifications at any time
and without notice.

All rights reserved
Ink Cartridge: The IP500 has been engineered and designed to work with ATD ink Cartridges.

The IP500’s Smart Level Ink Detection System, which provides ink level monitoring to ensure
complete ink usage and product safety , will not function if non-ATD ink cartridges are fitted.

Warranty:

The IP500 Thermal Jet system, including all components unless otherwise specified,
carries a limited warranty.

The inks and conditioners used with the IP500 Thermal Jet system carry a limited
warranty.

For all warranty terms and conditions, contact ATD for a complete copy of the Limited Warranty
Statement.

Copyright
Copyright ATD Ltd. 2009-2010
Revision history

V1.0.0 31/10/09
V1.0.1 23/01/10 Minor text corrections. New programme locations on CD.
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Section 1: Safety and Ink Cartridge Usage

Following is a list of safety symbols and their meanings, which are found throughout this

manual. Pay attention to these symbols where they appear in the manual.

® >eBp®

Wear safety Goggles when performing the procedure described

Caution or Warning! Denotes possible personal injury and/or damage to equipment

Caution or Warning! Denotes possible personal injury and/or damage due to
electrical hazard.

NOTE: (will be followed by a brief comment or explanation.)

ESD protection should be worn when servicing internal printed circuit boards. After
service to the equipment is completed, replace all protective devices such as
grounding cables and covers before operating the equipment.

It is extremely important to:

* Clean up all spills with the appropriate solvents immediately and dispose of all
waste according to local and state regulations.

» Wear safety glasses and protective clothing, including gloves, when handling all
inks and conditioners.

« Store inks and solvents under the recommended conditions found on the MSDS
(Material Safety Data Sheet).

Ink Cartridge: The IP500 has been engineered and designed to work with ATD ink
cartridges. The IP500’s Smart Level Ink Detection System, which provides ink
level monitoring to ensure complete ink usage and product safety, will not be
functional if used with non-ATD ink cartridges.
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Section 2: Quick Start

Typical Installation

Pack Contents:

* IP500 Print Head

* Bracketry Kit

» Power Supply, 15V

» Power Supply Bracket
» Power Cord

* Software CD

Step 1: Assemble Bracketry
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Step 3: Assembly of IP500 and PSU to Bracketry
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Ensure tar is
behind front
face of TJS0D

Step 4: Adjust The IP500 Print Head to Substrate
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Adiust the IPS00 vertically to meet print requirement

Adjust the IPS00 horizontally 1o et the print gap

ADJUST THE IP500
WERTICALLY WATH
EITHER OF THESE
TD BRACKETS

= o —

S

2.5mm [ 01" GAP
IS RECOMMENDED —

Step 5: Insert Cartridge into Print Head

ADJUST THE PRIMT
HE&AD TC THE
SUBSTRATE WITH
THIS BRACKET
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r';;\
To Open I-.\
Fotate Cover E&%\

--"‘--\.__

Inzert cartridge at an angle up to
cattridge stop

L Wh;inser‘ting cattridge, sim nose at an angle towards
the black pogo pin component. Slide catridge up to
cartridge stop.

Finger Releass Tah
Rutate Catridge down until it [ Fingerhelease 1a

snaps into place

l MOTE: The catridge is releazed by
N presszing down on the Finger

@Il Releaze Tab and pulling up on the
rear of the cartridge

Close Cover
Atter cartridie is -
ingtalle T
T

Step 6: Cabling, Power, and Serial Port Setup

ATD IP500 Operator Manual
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CAUTION: The Power should be dizconnected from the print head prior to
& connecting any external device such as the PC. Electrical arcing may ocour if
external cabling iz connected or diconnected wwhile power iz supplied to the IPSO0

PC or LAPTOP
N ./

{ i AR
(L 1l
(AR Firi

CObd PORT

CAUTION: The Power should be dizconnected from the print head prior to
& connecting any external device such as the PC. Electrical arcing may ocour if
external cabling is connected or diconnected while povver is supplied to the IPS00
Inztall the povweer plug from the
previouzly mounted PEL in to the jack
plug situsted on the rear of the IPS00
prirt head

Press and hold the "PURGE" button on the
rear of the IPS00 while slowly moving a
piece of paper in front of the IPS00
catridge. Print several purge images and
validate that all channels are printing. If nat
refer to "SECTION 4: Mairtenance and
Shutdowes" on page 21

', MOTE: Do not rub the face of the ink

w cartridge with the print material a2 in
will zcratch the arifice array and affect
the print quality
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Install the IP500 PC software using the CD included with the system:

Note: Before installing the software confirm that the PC has an unused serial port. If it does not,
install a serial port (internal card or USB) before installing the IP500 software.

Insert the CD and wait for the options screen.

~eTe IP5
marking systems
oD i~

| Install IP500 Editor j |

View Operations Manual |

View IP500 Parts Catalogue j

View IP500 Inks Catalogue

Visit the ATD website j

- Exit

Click the 'Install IP500 Editor' button. Follow the installation prompts.

If the options screen does not run automatically browse to the CD and run 'IP500_CD.exe' or
open the 'Editor' folder and run 'IP500_Editor.exe'

If you are installing under Vista or Windows7 it is recommended that you do not install to the
default location ('C:\ Program Files' folder). Create a folder in the root (say 'C:\IP500') and install
to there (Vista's security settings may prevent the programme saving data in the 'Program Files'
sub-folders).

-

After installation launch the programme by clicking the desktop icon EESSSEZUEN or run 'jj.exe'
from the folder you chose for installation.

B C:\Program Files\InkJet [J

Tazk 1: Hone [+ 1

Status u

Shoewe =
Mera =
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file:///C:/IP500

Ensure the Main Screen menu is present via the Hide Menu / Show Menu button

[ C:\Program Files\IinkJet 1

Tazk 1: None [+ E

: = o
=

Contraol
Fanel=

Date -

Hide
Meru

Meszsages

oof

Time & pﬂq

Status u |

P
P

]

%

Press the Control Panels button.

[ C:\Program Files\inkJet 1J

Inputs & EE Systern
Outputs ol Setup
Tazk 1: H o
Ltilitie= Metwaork
1 Uzer Regional S T
Boness Settings I| o2l
Close Menu

: = 2
= W WA

Status

Hide
Mera

13

Press the System Setup button and then the Serial Ports tab.
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I C:\Program Files\nkJet 1) = q I8 C:\Program Files\InkJet 1)

Pat | Baud | Function
COm1 J 57600 | Senal Print Head: Task 1 -
| 57600 | Mone -
Redo Print Head Setup |
Print | serial Print Task [ | Serial
|! Encoder %} Vet eria 2 |! Encoder ; %
Head! i Port:
eads \ Options [ | Parts Q‘ Heads \ Options  [7 | Perts Q‘
| Cancel I Ok | Cance| | ak |

Press the first Port/Baud button and ensure the baud rate is set for 576500.

[ 9 C-\Progran Fliesinklet L)

L9 C-\Program Fileriiniclet 11

Seainal Pail 5

|Pot  (Basd | Funstion
SR = | Hons

P00 = |Mone

L e

oK |

Select the COM port from the list. This is the port on the PC that the serial cable is connected to.
If a USB to Serial converter is being used the device will appear in the list of ports, however it
may be necessary to determine which port number has been assigned to the device by trial and
error (or look in the Device Manager for a listing of installed COM ports).

Press the OK button to exit the Serial Port Setup screen.

Press the Function button and select the Serial Print Head option. Press the OK button to exit
the Function screen.

[ 3 C:\Frogram Fleginklet LI 9 C:\Frogram Fliesinkclet 1)

I I Hane

|Pot | Bmsd Fumohon 'p“ Commeand £ Cantral

o1 T57%00_+] Hore x | B o esane Loak Up
S50 - Mo 1

ﬂmﬂ-%ﬂ A
Carod L

ok | : |
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Step 7: Configure the Print Head

Press the Print Heads tab and then the Redo Print Head Setup button. Select the desired
direction.

[ O Progras §lesinklat L1

[§ O Progran Flssirklst L1

J = =
T
Tomschy 5 passt b abroe] oy vaesn o0 3 pecchict theon
chesree that pand hess peopeter.
Bk s T b | Trousch i beoe that isprarsnts the product's

e hon o el 34 e Ao oLt coniraliar

e

Tl ] [ | Lancel

Select the number of print heads and identify the first in the daisy chain.

Berowmrmmncs KO EENEc e e v EICE
—pp 5 P 5
| W | W
yeovere Wer yeorere W
— Scdy the rumbad of pird sy ———————— — [serillly wi vl iy
M Sk Fut Sicha preatead
Tt B prd b sl ppaom s L] aehup compisls
mmmm“m 1 e Fimsl o i posr daiy chain [The one
Pt ke AI gy deictly wilo o Cort ol | -
i e |
Caresl | iBack | Neds | [ | | o |

Print head setup is complete.
Next, select the Encoder tab:.
Click one of the three options:
External Encoder:

This option should be used if the line speed varies. The encoder will track the changes and
produce constant size characters.

Line Speed is measured by an externally mounted encoder and connected to the last IP500 in the
daisy chain. The encoder should be configured to produce 300 pulses per inch (11.8 pulses per
mm) of product travel.

The encoder and wheel supplied by ATD (IP50-SPA00001) will be pre-configured for this rate. If
the encoder is to be connected directly to a shaft the pulses per revolution may need adjusting.
Contact ATD for assistance.

ATD IP500 Operator Manual
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[ C:\Program Files\inkJat 1)

)N N

External encoder; 300 ppi

N :
Frint ) Encoder %} Ta_sk I- Serial %
Heads \ Options p Ports
Cangel I 0K |

Auto Speed Detect:

The line speed is automatically detected via the IP500 photocells built into the front of the
printhead. This is the easiest option and should be chosen if possible.

[ C:\Program Files\inkJat 1)

P NN

Auto Speed Detect

N :
Frint ) Encoder %} Ta_sk I- Serial %
Heads \ Options p Ports
Cangel I 0K |

Fixed Speed:

The operator enters the desired line speed value. This option should be chosen if the line speed
is constant but an external product sensor is being used (see below)

[ C:\Program Files\InkJet 1)

@ NN

Line speed:

Fized Speed

30 fdmin

Frint )
Heads ‘ll Encader %
nrin

Tazk
Oplions

m
I

Serial
Forts %

Cancel |

OK

Click the Task Options tab:

16
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I C:\Program Files\inkJet 1J

Tazk options
’7 ™ Esternal product sensor.

Pririt |! — %} S T seria
Head plicns Port
2ads ~ F arts

Cancel I Ok |

If an external product sensor is being used (normally a photo-cell) tick the External Product
Sensor box:

If the box is cleared printing will be triggered when a product passes the built in detector in the
front of the printhead.

Note: selecting External Product Sensor disables the Auto Speed Detect function. Select either
Encoder or the Fixed Speed option on the Encoder tab.

Click OK to save the configuration and return to the Main Screen.
Step 8: Create a Message

From the Main Screen show the Main Menu then select the Messages button and then the New
button to enter the message editor.

[l C:\Program Files\inkJet 1) [ C:\Program Files\InkJet 1J g@|g|
Messages Task 1: New [
Cap Tissues ¥ | E |<'_-*_'_- _,|| Side 1 Side 2
I ESSD File Menu QUiCk Saqu | 1 1 1 1 I5 1 1 1 1 1IU 1 1 1 1 1I5
lames \ ‘
[RET
l M emtest
E ‘ | Messagern \ - e - Mext Field Font: Arial 150
Cancel ® Dzl atbe B] Me
Message
Step Qu'Méssage Edito Display area
. . 1
Creating a new text field <
/
Click somewhere in tth(/Iess Xt
Printhead number
'i::é Adle v Mext Field I Fant: &rial 150
251 of I AT e

A DI

\
\
AN
\
\
\

Next Field selection Font selection



B C:\Program Files\InkJet 1J @\E\g|

Tazsk 1: Hew [+
Side 1 Side 2
1 1 1 1|I:I 1 1 1 1 1|5

[—]

TR0 Y Mext Field Famb: frial_150 |

lTe:-:t here G-I-b

A

When the cursor is displayed in the message area entering text on the keyboard will automatically
create a new text field at the cursor position, using whatever font is currently selected.

Click on the Message Display area to finish entering text.
Selecting a Font

Click the Font button and select a new font:

[ C:\Program Files\nk.Jet 1J

Tazk 1: Hew [+ B

| Fonts

= | ide 2

= = |&rial_150 e
L |Arial_30 R

b
w

Cancel ok |

Al = | EerH] [ 7% ] |

Click in the message area to position the cursor and enter some text:

ATD IP500 Operator Manual
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[ C:\Program Files\InkJet 1J Qlil@‘

Task1 New =
1 Text -pe Small text o
1% 518 V.76 Mext Field | Fort: aciai_7s |

X! © mm

Note: Editor will prevent one field overlapping another. It will either display the cursor in red, or
bring up a warning message.

Click in a clear area of the message display to finish entering the field text.

[ C:\Program Files\InkJet 1J glilgl

Tazsk 1: Hew
Side 1 Side 2
10 15

2l =,
ﬂext 08 e

A o Mext Field I Fontb: Arial 130 I

A | [Terhed 5 |

Editing existing text

Click on one of the fields:

The field is highlighted. The text can be edited in the box at the bottom of the screen.
Click on the Font button to select a new font for the field.

Moving a field

Click on one of the fields:

The field is highlighted.
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Hold down the left mouse button and drag the field to position it in the message display area. The

area will automatically scroll with the dragging.

If a field disappears from the message display area when it scrolls use the Next Field button to

step to it.

Note: the fields will snap to allowed vertical positions. Fields using smaller fonts are automatically

aligned to a 'grid' in the message display area.

Field limitations

The IP500 can print a maximum of two fields at the same time (one above the other). It is
possible to enter more fields one above the other in the Editor screen if the fields use the small
Arial_30 font, however the IP500 will not be able to print all the fields.

Time, Date, Counter, Bitmap, Variable Text and Barcode fields.

Click to position the cursor in the Message Display area then click the required field button at the

bottom of the screen:

[ C:\Program Files\InkJet 1J

Task 1: New

2

Side 1 Side 2

EE&X

[+

N Mext Field

Text here aaf

|ant Brial _150

15

Time Date

Counter

Variable

| % q\"\'\\lllw\

Bitmap Barcode

Details of the field can then be set (see the section Programming the IP500 for more details).

Once the field has been created (with the selected font) it can be amended by clicking it to
highlight it, then clicking the Field button in the bottom of the screen:

20
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B C:\Program Files\InkJet 1J

Task 1: Hew

T ere ef

S 026 Y3 Mext Field I Font: frial _30

The example shows a Time field highlighted. Click the Time field button to amend the format, or
the Font button to change the font.

Deleting a Field

To delete a text field click on it to highlight it and then erase all the text in the box at the bottom of
the screen.

To erase other types of field click on it to highlight it and then press the DEL key on the keyboard.

Saving the message

Click the File Menu button

B3 C:\Program Files\InkJet |J

Rewvert H } Mew
= ” Side 2

-l_ Clear Open ! 1 1 1 1|5

1 27
1 Ik Usage 6 Save s . ﬁ
[]

, Test
Ed " Print (5

Cloze Menu o

'i::; Aoaad vl Mext Field | Font: Arial 150 I

A| Dl X! ® mml
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Click Save As... , enter a name for the message then click Save
Exiting the Editor

Click the File Menu button again and select Exit

Step 10 : Printing a Message

From the Main Screen menu, push the Print button.

I3 C:\Program Files\inkJet 1 DE®
Taszk 1: None [+

Slatus g
7 sh =
o | [ B

Click the required message to highlight it:

Bl C:\Program FilesMnkJet 1J Q|@E|

Print Task 1... Local

TizaLes

E ‘ | Message:lNewtest ’ |
Cancel ®| Frint It @|

Press the Print It button:

ATD IP500 Operator Manual
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B C:\Program Files\inkJet 1J E”E‘E‘

Taszk 1: Hewtest Q=

Texthee -

el
: - 8

. o Sh =
Frint... (ﬁl 1| M| Meﬁ‘:r =

The message will print on the next photocell trigger.
Pass a product in front of the printhead to trigger the photo-cell.

The position of the printing on the product can be adjusted from the Product Setup screen (see
Section 3, Programming the IP500)

ATD IP500 Operator Manual
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Section 3: Programming the IP500

Main Screen

Current B C:\Program Files\inkJet 1) ~ Print Menu
message
name ™~ . Primt
M.essage“ Tazk 1: CAP Messages | = Message
window - —— Editor
Control
REF: FLU200D Panels W
Configure
n Time & System
% Date
- » u | Set Time
B ~ and Date
P
Ink Status . 2 Hide Sy
| /F'F”"t---A (ﬁl 1/22] Qg M "?T{' |
\ f N\ . Show Status
| 3 \ screen
Print | | “
Start/Pause Quick print  Set Counter ~ Set variable ~ Show/Hide Main

Menu

Message Window

* Displays the current print message.

» Updated approximately every seven seconds, so it likely will not show each print.

* Long print messages can be viewed by using the F1 and F2 keys to scroll the message left and
right, respectively.

» White or beige bars represent a print head in the daisy chain and are identified by their
respective numbering.

» The header displays the name of the message currently selected

Print Start/Pause

If a message is currently printing, pressing the Pause button will discontinue printing after the
message completes printing.

If the message is paused press the Start button. Print will resume on the next product detected.

ATD IP500 Operator Manual
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L

Quick Print Select

Print... (5

Press the Quick Print button to bring up the Message Selection screen:

[ C:\Program Files\inkJet 1J BEx
Print Tasgk 1... Local
Cap Tizsues [

ESS0 IJ

James
Mew
|

Mewtest
)
‘ | Message:l } |
Cancel ®| Prinit It (ﬁl

Click to highlight the required message then click Print It

Main Menu

Click the Hide/Show Menu to collapse or expand the Main Menu:

[ C:\Program Files\inkJet 1)

B C:\Program Files\inkJet 1)

Task 1: CAP o=
1 Control & dLi 1
P 5 00 REF: FLU200D Farels 99| |P 5 0 0 REF: FLU200D
Time & L Tazk 1
& | || | e pqu ]|
Status g . Status g
Prirt... @l | ﬁg | dide i Pri... @l 1 ig i %
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Print Button

Displays the Print Menu:

B C:\Program FilesMnkJet 1J

Displays the
Tazk 1: [Temp) . = —  Message Select
‘P500 BE 2102 i — screen
— s
: Purge H 06
REF: FLU20D = e i
n

| Clzgz oo i ‘ Cancels printing
Meru S pﬂqj

Print... (ﬁl | ﬁf | e e Click to test fire the
A printhead.

oy a1 Hold some paper in
AT front of the head to

check all the nozzles
are firing.

o Repeat as
necessary.

Set Counter
Set Variable

Neither of these option are available from the Main screen. Click Print and select the message
again to enter a new value.
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Print Button (Main Menu)

B C:\Program FilesMnkJet 1J

[y

Taszk 1: [Temp] Cancel

BE 104 Print
1
‘P 5 00 REF: FLU200D Purge

Al

II Manu i

Messages Button (Main Menu)

Edit, create and delete messages:

Displays the
Message Select
screen

Cancels printing

Click to test fire the
printhead.

M Hold some paper in
Purge Tosi ] front of the head to

—_

check all the nozzles
are firing.

o Repeat as
necessary.

27
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Meszages

CAP Tizzues
ESSO
James

M ew

|| — /)
///,///// I ‘ | MESSEQEZINEWtESt ’ | J

;Iete EI Nf; j

S

Click to highlight Cancel ®
a message

«

/
/
/
/
//
/
/

Click to cancel Click to delete Click to open a new Click to open the

message Message Editor message in the

Message Editor

Message Editor Screen

ATD IP500 Operator Manual
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Quick

Zoom in/out

Save |
a C:\.Pg.ram FilesMnkJet 1J
Taszk 1: HNewtes=t
Cursor
| | —1 1 1 1 ] | | | 1 1 1 1 1 1 Message
1 1414 Display
~_ Highlight
| Next Field
v S TOE 9] Mext Field ] Font: frial 30 |
- \\
. ~ Set font
Cursor position
or top left of field / \ AN
when a field is / / | AN
highlighted / \ .
/ | N\ N
Insert Time Insert Date Insert Insert N
. : ; Insert Insert
field field (?ounter Variable Bitmap field Barcode
field field field

File Menu Screen

29
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Restores message

to the last saved Create a new
version message
Delete all
fields .
Open an
\ ~_— existing
B C:AProgram Files\inklet. 1) EEX g message
; Rewert W ’ Mew
Calclulate E
rints per =
Eartridpe T~ Claar Open | 1.5 Save
9 | - message to
LS a new
Inki Usage Saue M=,
name
co
Exit 1- ek (copy)
1 Frint
| Loadthe
e s TFont: Arial_150 | message to
the
Return to Main 2| 4| ©| wm printhead
Screen :

Return to

Editor

screen
Product Setup Screen

Panel Setup tab
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Print Option tab

[ C:\Program Files\InkJet 1)
 Product Setup
E — Length

— Left

a=
I 0.0 cm.

EEX

margin

| I—

.
Pamel =r= Print
|—_: Setup A | Opticns
Cancel | oK |
1 | ] [ ¥ 1 1
This sets the length of the Sets the position where the
Message Display area that printing begins from the
fields can be positioned edge of the product
within.
Note: if an External Product
Normally this value would Detector is fitted the margin
be the length of the starts where the product
product. triggers the detector. It is
recommended that the
detector is placed as close
to the printhead as is
practical. See Appendix D
for a fuller explanation.
| Tagk 1- Mewtest e

Frint options

E

'| I~ Side 2 = side 1.

[T Task 2 =task1.
1
[~ Cancel after one print.

&

¥ Repeat print atl 150 cm. intervals.

Fanel

|-_: Satup

£ 4l

Frint
Options

Canecel I

Ok |

T | 2aaannx])

7% ]

To print once on each product clear the check box
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Tick the Repeat Print check box and set the repeat print length as required to print multiple times

on the product.

Time Field Screen

E Time code format:
-
At TIME -
oo TIME
HH®kARA w
HHMIS S |
HH: kAR
HH: M S5

Bl C:\Program Files\nkJet 1J E|E|E|

I——-_1
Insert Time Code

Ok

I
Cancel |

|

4]

Select the required format for the Time field. The field will be printed with the currently selected
font. This can be changed by selecting the field and choosing another font.

Date Field Screen

Bl C:\Program FilesMnkJet [J

D ate code formats: D ate offzet

B - % Daps
Julian (001 - 366) [0
b

AT

BACI ™

DD kb ™

DIDBARAY ™™ b |

bARASDID ™ —_— Ok I
bAbA DD ™ v

rAR DD Y™ - Cancel

Select the required format for the Date field. The field will be printed with the currently selected
font. This can be changed by selecting the field and choosing another font.
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The date can be offset forward from the current date by the number of days entered in the Date

Offset box.

Counter Field Screen

[ C:\Program Files\IinkJet LJ

Taszk 1: Hewtest

S

EI0&

o

| Side 1 Side 2 |
in
1 1

L Insert Count
1 Start at: Stop at:
| 1 | 999959

Canzel | | Ok I

035 i1 Hext Field

| Font: rial 150

15
)

A 1f2p3]

Xl

T

Insert the Start (next print) and Stop values.

Variable Field Screen

[ C:\Program Files\InkJet 1J

Tazk 1: Hewtest

| p—

-|_— Yariable data source

|User |

Field name

|Shift Cade

% E dit ¥ariahle Field

= [ & ]
bl axirnuirn figld length:
I 2.9 centimeters Cancel |

J#s

Variables allow users to put information into the message without using the Editor. The IP500 will
prompt the user for the information to put into the field when the message is selected for printing.

Select 'User’ for the variable's data source.
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The Field name ('Shift Code' in the example) will form part of the prompt when the message is

selected for printing:

[ C:\Program Files\nkJet 1J

Task 1: Newtest

=l = |

[ J
T K
@, Enter the
! @ Shift Cade:
|
‘- Cancel I Ok I _I
A ITEchere| 4-I-v

Set the maximum length for the field to prevent data from overwriting another field.

Bitmap Field Screen

B C:\Program Files\InkJet [J
I Inzert Logo

Preview: Copy of kest brap

o)

TEST

Select Lago... I

Cancel I

v|al)

Ok |

Use the A Ykeys to select the required logo.

Alternatively click 'Select Logo' and choose from the list
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Bl C:\Program Files\nkJet 1)

Brevion Select Logo. ..

E ‘recyn::le.bmp \

Y

v

Sele

Canzel Ok

Note: the logos shown in the list are the .bmp files found in the bmps sub-folder of the installation
folder. Move any bitmaps files you wish to print to that location first.

The default installation folder is 'program files\inkjet\bmps' . If you have installed the Inkjet

programme in a different location move the required bitmaps files to the 'bmps' sub-folder of that
location first.

The bitmaps files must be loaded to the IP500 printer using the TJ_500.exe programme before
they can be printed. The IP500 can support up to 3 bitmap files in its memory. See Appendix H
for more information.

Barcode Field Screen

Bl C:\Program Files\inkJet 1J Q‘E‘EJ
r—'——"

=l Inzert Bar Code

E Bar code data J
=l 1234567840 =

12345678307 3
Bar code twpe [rata source
| JUPC-A | |Fixed =]
Cancel I Ok

_=======_

Enter the 11 digits for the UPC-A barcode (the value of the 12" digit will be calculated by the
IP500).
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Control Panels Menu

B C:\Program Files\InkJet IJ

Inputs & E

Outputs 6'4_;

Swstern
Zetup

Utilities @

Metwork

Lzer
fBocess

Regional
Setting=

Clo=ze Menu

= -

i E',:_
=

=

. = it
o B | ]

Inputs and Outputs

Not relevant to the IP500. Settings will have no effect

Network

Not relevant to the IP500. Settings will have no effect

System Setup

See Section 2, Quick Start for details

Regional Settings
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B C:\Program Files\nkJet [J

Frimt %
J

Language .

I . Unitz of measure ———
English  Us ,

1 Porugués 5. cuztomary
Espafiol * Metic

t - oK | JH
v cancel | J
S ma 2| Wi/ BT

Select the User language for this programme, and the units of measure (inches or metric)

Utilities:

[ C:\Program Files\InkJet 1J Q\§|@

Select Funchion
FRestare default configuration :I
Defrag flash memaony

Testtouch screen
Calibrate touch screen

Reset maintenance timer
File manacger

kM akes previously used memory available for reuse.

| Diore I Do Function

These functions are not relevant to IP500 operation, or are for service use only.

Time & Date Setting Screens
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[T

\ 1:35:u .

Fonst & 12k Mies

B Hen fum 'Wed | Thu P

o
I [ [ = o | o
11 18 13 14 1% 1%
3 O Ol |~ B -
a5 20 a7 | &= I

w @[ -

- @]

. id 4
13
i
17
[ |
ED

| pply | ox |

Canasl | iy |

ox |

Sets the IP500 clock and calendar (to ensure accurate time and date fields).

Status Screen

For Service/diagnostic use:

Bl C:\Program Files\InkJet 1J

Head 1 e’

i & Product detect
% Frinting

ik o

2003-11-02 15:16
Yersion 5.2.0304080332

Fonts and logos

Anial 75
Arial_150
Aial_30

I Task 1 ne”  Memory Usage fl

Ok
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Section 4: Maintenance & Shutdowns

Daily Maintenance, Ink Cartridge

Prior to shift start-up, the cartridge orifice array should be cleaned of any debris build up:

Equipment:

* Deionized or distilled water
» Sponge Swabs (p/n: IP50-SPA00005)

Procedure:
* Lightly dampen sponge swab with de-ionized water.

* Rub up and down across the orifice face with light force several times with one side of
the sponge swab.
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* The printhead should be clean and free from ink

* Immediately press and hold the PURGE button on the rear of the print head for 5-10
seconds to clear any excess de-ionized water in the orifices. Because ink will eject during
the channel purging, a piece of paper, cloth, or comparable material should be held in
front of the orifice array.

* Do NOT hold the ink catch material against the orifice array as print quality will be
degraded.

» If print quality becomes unsatisfactory during operation this procedure can be
repeated.

Weekly to Monthly Maintenance, Print Head

Debris and ink build up on the print head enclosure / cover can be removed using a soft
cloth lightly dampened with deionized water.

Take care NOT to wipe the cartridge orifice array.
Shutdowns Less Than 3 Days

The ink cartridge can remain in the print head uncapped. When restarting the print head,
follow the Daily Maintenance procedure.

Shutdowns More Than 3 Days
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For extended shutdowns, follow the Daily Maintenance procedure, remove the ink cartridge from
the print head and store in the optional Cartridge Boot Cap (p/n:IP50-SPA00009).

Genuine ATD ink cartridges will store the ink used in the cartridge memory, so proper ink
level monitoring can continue when the cartridge is re-fitted for use.

CARTRIDGE BOOT CAP

ATD IP500 Operator Manual
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Section 5: Troubleshooting

No Print

System Symptom

Possible Cause

Actions

No print head power /
green LED on rear of
print head

» Power Supply
» AC Source

» Check power supply light indicator.

*» Check for AC power source between
power supply

input limits.

PURGE button on rear
of head does not
appear to work

* Ink cartridge is damaged
or empty

* Print head Board fault

* Replace with new cartridge and repeat
PURGE.

* Replace print head printed circuit board
or print
head.

Print head purges but
won'’t print desired
message

* Loose or missing
cables

« Controller or PC software
not configured for
Serial Print Head

« Encoder Malfunction

* Product not triggering
photocell.

» Tighten or install all cables.

* Ensure print head(s) are configured as
serial. See Section 2: Quick Start, Step 6:
Cabling, Power, and Serial Port Setup

* Ensure encoder is installed and plugged
into the last print head in the daisy chain.

« If the encoder is installed, navigate to the
controller Status screen from the Home
screen. While the encoder is turning, check
the line speed for greater than 0 m/min.

* Ensure the product is within 3mm of the
front face of the print head.

« If an external photocell is installed, then
validate the setting from the Control
Panels, System Setup, Task Options Tab.

Poor Print Quality

System Symptom

Possible Cause

Actions

Print is foggy or light

* Print head is mounted
greater than ~3mm
away from the substrate

+ Adjust the print head according to Section
2:Quick Start, See Step 4: Adjust IP500
Printhead to substrate.

If the product surface is not consistently
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* There are large air
currents
near

positioned the IP500 roller and retractor set
may be necessary (part no.
IP50_SPAO00013)

* Locate print head in an area where there
are minimal currents or provide wind
barriers.

Print image is missing
channels or has
multiple

lines or segments

* Pen cartridge face is
dirty

* Pen cartridge face is
damaged at the orifice
array

* Pen cartridge is not
properly seated in the
print head

* Clean the pen face per Section 4:
Maintenance & Shutdowns.

* Replace damaged pen cartridge with
new.

» Remover cartridge and reinsert according
to Section 2: Quick Start, Step 5.
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Appendix A: Specifications

IP500:
r.i 158 .2mm —_— = I3Emm
,I TS
Oie P
|
/
| _¢ E ?_ 0o 92.6mim
: i
35.9mm ‘ | — '
I', I |
\ 22 1mm
20,3 —fa—mg 3% WG x4 3.05mm depth Lowest |
25 EHTIT] et provided for print head mounting. Channel
Mate: The maximum allowable fastener
penetration depth iz 4 6mm. Beyond thiz,
internal damage will ocour
Weight: 0.6 kg
Enclosure

Anodized Aluminum and Stainless St eel

Electrical
15 VDC from power supply to print head
Power Supply: 90-260 VAC, 50/60 Hz, 1.5 A max.(per PSU)

Print Speed
200 fpm, 300 dpi continuous

Print Resolution
300 dpi

Throw Distance
Recommended Gap: 2.5 mm
Maximum Gap: 6.3 mm

Print Direction
Between horizontal and downwards FRINT HEAD TILT

Print Head Tilt
+/-45° from vertical

Maximum Number of Vertical Fields
2 per print head

File Storage

Three factory installed fonts: Arial 30, 75, and 150
Up to three bitmap files: 150 dots tall

(12.7mm) X 2046 wide (173 mm)

Environment

Ambient operating temperature: 50°F to 104°F (10°C t 0 40°C)

ATD IP500 Operator Manual
44



Operating Humidity: 10% - 80% RH

Ink Type

Porous Black or Non-porous Black

Ink Cartridge

The IP500 has been engineered and designed to work with ATD ink cartridges.

The IP500’s Smart Level Ink Detection System , which provides ink level monitoring to ensure
complete ink usage and product safety, will not be functional if used with non-ATD ink cartridges.
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Appendix B: Theory of Operation
IP500 TIJ Technology

The IP500 print head is a form of Thermal Ink Jet (T1J) based on the hp® 45A cartridge.
TIJ technology works on the principle of rapidly heating ink at any particular addressable
channel. As the ink is heating, it ejects from the orifice of any combination of channels.
Because channel orifice sizes are very small, many more orifices can be compacted in
the same amount of space as conventional print technologies. With more orifices per
vertical inch / millimeter, a much higher resolution image can be produced.

IP500 Operation

Up to four IP500 print heads can be daisy chained. A message can be sent down to the
IP500(s) via the included GUI software interface program for a computer. Additionally,
the IP500 can be programmed to print one or two lines of print, and any combination of
alpha / numeric, date / time, count, variable, logo, or UPC-A barcode fields. Logo’s
cannot be longer than 2046 columns (173 mm). Variable fields can only be changed
when the message is selected to print.

The GUI interface computer can be disconnected from the print head daisy chain while
printing; however, status information to the GUI will be lost until reconnected.

Essentially the GUI interface provides the initial setup and message information. After
the operator sends the print command, the IP500 takes over and the GUI only reports
status information.

Ink Cartridge Ink Status

Each ink cartridge contains approximately 42 mL of ink and has been programmed at
ATD so as to make full use of ink level status. When a new cartridge is snapped into the
IP500, it is identified and ink level is monitored. As the ink depletes to 10% ink,
remaining, Ink Low, the red LED on the rear of the print head turns on steady. The red
LED changes to slow flashing, Ink Out, when there is approximately 2% ink volume
remaining. The ink cartridge should be replaced at this point. At 0% ink volume
remaining, the red LED changes to fast flashing indicating that the cartridge is empty
and print is disabled. Ink status is reported back to the GUI software as long as they are
connected to the print head daisy chain.
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Appendix C: Font Samples

Arial 30- 3.1 mm:
AaBbCcDdEeFf
1234567890

Arial 75 -6.35 mm:

AaBbCcDdEeFf
1234567890

Arial 150 -12.7 mm:
AaBbCcDdEeFf

1234567390
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Appendix E: Creating Logo Files

Open Paint from a PC by selecting Start, Programs, Accessories, and then Paint.
Bring up the Attributes dialog box by selecting Image and then Attributes.

i untitled - Paint

File Edit W%iews Image Colors Help

o 1NN T N O I
S rEECEEEEC S S

Far Help, click Help Topics on the Help Menu.

Enter the Width and Height of the logo in Pixels. The maximum number of pixels for
width and height is 2046 and 150, respectively. Select Black and white for the Colors.

Attributes

File last saved: Mot Available

Size ondisk: Mot Available

Fiesolution: 96 % 96 dotz per inch
widh: Height (32 | [ Defeur |

Lniits

O Inches O Cm (%) Pinels

Colars

() Colors

Choose Yes at the screen prompt to convert to black and white if applicable.
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' Converting to black and white cannot be undone,  This action affects the current file and may cause some loss of color information.
Do you want ko conbinue?

1 1 I
Sl (I T | (R

Far Help, click Help Topics on the Help Menu,

Bring up the Flip and Rotate dialog by selecting Image, Flip/Rotate

Select Rotate by angle, then 270°. Click Ok.

Flip and Rotate

Flip or ratate
) Flip harizontal
- Cancel
) Flip wertical
(%) Rotate by angle
Car
O180°

©ir:
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i untitled - Paint \Z||§HX|

Elle Edit Wiew [mage Colors Help

] 00 /3 SN S
W 0fR~ =0

s IEENEEEET NS
S TR T S

For Help, click Help Topics on the Help Menu,

From the File Menu, select Save As and save in the "bmps" directory inside of the
installation directory (default location “c:\program files\inkjet\bmps”).

Note: bitmaps files that will be used in messages must be uploaded to the IP500
(maximum 3 at any one time). See Appendix F for details.
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Appendix F: Uploading Files to the Print Head

o\

CAUTION: Power must be disconnected from the print head prior to connecting or
disconnecting the PC serial lead, photocell, encoder or print head daisy chain cables.

Electrical arcing may occur if external cabling is connected or disconnected while power
is supplied to the unit.

Ensure the firmware upgrade program TJ_*.exe is installed on a local computer (* is the
version, and may change from time to time). It can be found on the IP500 CD in the
'Editor’ folder. Simply copy the file to the PC.

Connect a DB-9 serial cable between the computer and the print head and re-connect
the Power Supply.

Run the TJ_*.exe program and step through the screens until the Serial port and
operations selection screen appears.

If only BMP and / or font files are to be uploaded, then uncheck the Upgrade Firmware
box.

Select Next.

Select or clear the files to be uploaded. For BMP files, highlight bmp 1, 2, or 3, and
Browse to the already created bmp file (See “Appendix E: Creating Bitmap Files” )

This firmware allows up to 3 font files (*.hfnt) and 3 .bmp files to be loaded on any print
head at one time.

NOTE: The .bmp file must reside on the PC for message creation, and must be loaded
to the print head in order to print it.
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